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Manual versions

This manual describes the Flasher Hub, and (in part) the Flasher Compact, which can be con-
nected to the Flasher Hub.

For further information on topics or routines not yet specified, please contact us.
Print date: June 10, 2021
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About this document

Assumptions

This document assumes that you already have a solid knowledge of the following:

The target processor.
DOS command line.

The software tools used for building your application (assembler, linker, C compiler).
The C programming language.

If you feel that your knowledge of C is not sufficient, we recommend The C Programming Lan-
guage by Kernighan and Richie (ISBN 0--13--1103628), which describes the standard in C pro-
gramming and, in newer editions, also covers the ANSI C standard.

How to use this manual

This manual explains all the functions and macros that the product offers. It assumes you have
a working knowledge of the C language. Knowledge of assembly programming is not required.

Typographic conventions for syntax

This manual uses the following typographic conventions:

Style Used for
Body Body text.
Keywor d Text t.hat you entgr at the commgnd pnjompt or that appears on
the display (that is system functions, file- or pathnames).
Par anet er Parameters in API functions.
Sanpl e Sample code in program examples.

Sanpl e comrent

Comments in program examples.

Reference to chapters, sections, tables and figures or other doc-

Reference

uments.
GUIElement Buttons, dialog boxes, menu names, menu commands.
Emphasis Very important sections.
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Chapter 1

Introduction

This chapter provides a short overview about the Flasher Hub and its features.
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11 CHAPTER 1 Flasher Hub overview

1.1 Flasher Hub overview

SEGGER'’s Flasher Hub is a Control Module for parallel programming.

The Flasher Hub is able to control up to 24 Flasher Compact modules serving as individ-
ual channels for parallel, high-speed gang-programming. If required, each channel can be
configured to program a different device with a different firmware image.

The Flasher Compact modules connected to the Flasher Hub are set up just once per channel
configuration using SEGGER'’s Flasher software package. The software to be used depends
on the type of flash chip being programmed. The Flasher Hub can receive commands and
send results via telnet conection “stand-alone”, without the need of a desktop PC. The
combination of a single Flasher Hub and multiple Flasher Compact modules is the perfect
solution for high-volume mass production.

The Flasher Hub supports all flash devices and programming interfaces supported by the
Flasher Compact. By using Flasher Compacts as the programming modules, the Flasher
Hub takes advantage of the extensive list of supported devices and target interfaces, plus
the ultra-fast programming speed and reliability of these ‘Almost-Anything’-Programmers.

1.1.1 Features of the Flasher Hub

e Stand-alone In-System Programming (ISP) hub

e Scalable solution with up to 24 supported individual parallel programming channels,
each with their own programming circuit memory

e Built-in web & FTP servers for easy setup

e Includes Flasher software package

Flasher Hub User Guide (UM08039) © 2020-2021 SEGGER Microcontroller GmbH



12 CHAPTER 1 Flasher Hub overview

1.1.2 Working environment

General

The Flasher Hub has been designed to be used in conjunction with automated test equip-
ment (ATE). It is modular and scalable from 1 to 24 individual programming modules, rep-
resented by SEGGER Flasher Compacts. The Flasher Compacts are connected to the Flasher
Hub via powered USB hubs.

Flasher
Hub

USB Hub

(powered)

Flasher PC-software (J-Flash / J-Flash SPI)

In order to prepare the firmware / data to be programmed to the targets and download it
to the Flasher Compacts, the latest version of the J-Flash / J-Flash SPI software is required.
J-Flash / J-Flash SPI are available for Windows, Linux, and macOS, and are part of the
Flasher software and documentation package, which can be downloaded from our website:
https://

www. segger . conl downl oads/ f | asher/ #Fl asher Sof t war eAndDocunent at i onPack

For more information about using J-Flash, please refer to UMD8003_JFI ash. pdf (J-Flash
User Guide, available at htt ps: // ww. segger . con’ downl oads/ f | asher/ UMD8003). J-Flash
SPI is described in UMD8001_JLi nk. pdf (J-Link User Guide, available at htt ps://ww. seg-
ger.com downl oads/j | i nk/ UMD8001).

FTP Client

The firmware to be programmed to the targets can also be uploaded to the Flasher Com-
pacts via an FTP connection to the Flasher Hub. For this, an FTP client is required.
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13 CHAPTER 1 Flasher Hub overview

Web Browser

The Flasher Hub’s web interface offers a lot of useful status information about the system.
It also allows firmware updates to the Flasher Hub and the connected Flasher Compacts,
uploading the firmware to be programmed to the targets, configuring the index of the
connected Flasher Compact modules, and more. In order to access the Flasher Hub web
interface, a web browser is required.

Terminal program

For communication with the Flasher Hub via Telnet, a terminal program like TeraTerm or
PuTTY is helpful.

Universal Flash Loader Configurator software

The latest version of the Universal Flash Loader Configurator software can be downloaded
from our website at htt ps: // ww. segger . coml downl oads/ f | asher .

This software is only needed if the device you would like to program requires the usage
of the Universal Flash Loader.
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1.2 Specifications

1.2.1 Specifications for Flasher Hub

Specifications
Power supply USB C-powered, max. 3.0A
ng ;rlltssr;aces (for connecting powered 2x USB 3.0, 2x USB 2.0
Host Interfaces FTP, TELNET
Operating Temperature +0 °C ... +50 °C
Storage Temperature -20 °C ... +65 °C
Relative Humidity (non-condensing) <90% rH
Safety notes For indoor use only.
Size (without cables or mounting brackets) | 60mm x 32mm x 95mm
Weight (without cables) 132g

1.2.1.1 Supported CPU cores

The Flasher Hub itself is CPU-core agnostic. The supported CPU cores are determined by
the connected Flasher Compacts. Please see the Flasher Compact User Guide for details.

1.2.1.2 Supported Target interfaces

The Flasher Hub itself is target-interface agnostic. The supported target interfaces are de-
termined by the connected Flasher Compacts. Please see the Flasher Compact User Guide
for details.
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Chapter 2

Working with the Flasher Hub

This chapter describes functionality and how to use the Flasher Hub.
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16 CHAPTER 2 The Flasher Hub

2.1 The Flasher Hub

The Flasher Hub makes ultra-fast, high-speed parallel programming (*gang programming”)
possible. Via powered USB hubs, up to 24 Flasher Compact modules can be connected to
the Flasher Hub. Each Flasher Compact module is connected to a target device.

Flasher Hub

Telnet/ FTP /HTTP

* J-Flash
* Terminal SW
* Web Browser

* FTP Client USB Hub

* Terminal SW
* FTP Client

* Web Browser Flasher

Compacts

Target
Boards

Via a Telnet connection between the ATE (Automated Test Equipment) and the Flasher Hub,
flash programming operations can be triggered and responses from the Flasher Hub can
be read and evaluated. This makes the Flasher Hub a perfect fit for small-scale as well
as large-scale production environments. The firmware to be programmed into the target
devices can be prepared via a computer running Windows, Linux, or macOS and SEGGER'’s
J-Flash or J-Flash SPI software. The Flasher Compact modules connected to the Flasher
Hub can be provisioned with the firmware to be programmed either directly via J-Flash, via
an FTP connection to the Flasher Hub, or via the Flasher Hub’s web interface.

2.1.1 Power supply

2.1.1.1 Flasher Hub and Flasher Compact power supply

The Flasher Hub needs to be powered via a 5V USB-C power supply (1.0A or higher; not
included).

P Flasher Hub [ &

%m

The Flasher Compacts are powered by the powered USB hubs through which they are
connected to the Flasher Hub.
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Current consumption (typical)

CHAPTER 2 The Flasher Hub

Flasher Hub

5V via USB-C connector

‘ 800 mA (Ethernet connected)

Flasher Compact

5V via powered USB Hub

130 mA (no target power supply)

5V via powered USB Hub

230 mA (target power supply with 100mA)

Note

Note

not powered sufficiently.

2.1.1.2 Target power supply

Don’t connect Flasher Compact modules directly to the Flasher Hub. Always connect
Flasher Compact modules to the Flasher Hub via powered USB hubs.

Undefined behavior may occur if the Flasher Hub and/or the Flasher Compacts are

The target boards to be programmed can either be powered via their own power supplies,
or they can be powered via a 5V / 100mA supply from the Flasher Compacts. Please refer
to the Flasher Compact User Guide for details on how to do this.

Flasher Hub User Guide (UM08039)
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18 CHAPTER 2 Setting up the IP interface

2.2 Setting up the IP interface

The Flasher Hub is equipped with an Ethernet interface to communicate with the host sys-
tem via your network.

The Flasher Hub also has a built-in web server that provides system status and allows
system configuration.

2.2.1 Connecting for the first time

When connecting the Flasher Hub to your network and powering it up for the first time,
it attempts to acquire an IP address via DHCP. After the Flasher Hub has finished booting
(i.e. after the green LED has stopped flashing), you can connect to the Flasher Hub’s web
interface by pointing your web browser to http://flasherhub-<serial_number>/. (Make sure
to replace <serial_number> with the serial number of your Flasher Hub, which can be found
on the housing.)

The “"Overview” page served by the Flasher Hub’s web server contains the IP address that
has been assigned to the Flasher Hub by your network.

b\_ Configuration » Status - About Log Debug
'/ SEGGER

Control

Restart Restart now

General information
Sarver version 1.00

Serial number 1021000000

Network information

Configuration Automatic (DHCP)
I 1P address ! 192.168.11.224 /16 I
" Gateway 19271687131 '

Last program result 0.K.

11| Flasher Wl| Flasher Jki| Flasher 1| Flasher || Flasher @| Flasher Jd| Flasher J| Flasher

lflm E]| Flasher 19|m b1l Flasher 31| Flasher ¥1| Flasher 23]@ 24|m

Note

Don’t connect the Flasher Hub directly to the Ethernet interface of an ATE or host
computer. Only connect the Flasher Hub to your network via a router, switch, etc.
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CHAPTER 2 Operating modes

2.3 Operating modes

2.3.

The Flasher Hub currently only operates in remote-controlled mode. (Handshake mode is
planned to be added in the future.)

In remote-controlled mode, the Flasher Hub receives commands via Telnet connection and
reports the results back to the caller. This allows the caller to check whether the desired
operation was executed successfully or not.

1 Remote-controlled mode

The remote-controlled mode provides a way to integrate the Flasher Hub into a production
environment and control it via Ethernet. In this setup, the Flasher Hub provides detailed
status information that can be used to verify the success of the programming sequence,
optimize the production setup, and identify errors.

In order to use a Flasher Hub based system in remote-controlled mode, the connected
Flasher Compact modules need to be configured first. This is described in Setting up Flasher
Hub for remote-controlled mode on page 26.
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CHAPTER 2 LED status indicators

2.4 LED status indicators

The Flasher Hub uses different LEDs as indicated in the following table.

2.4.1 LED indicators

# Status of LEDs Meaning
GREEN L
1 flickering SD-card access / booting in progress.
2 RED The Flasher Hub is powered.
constant

2.4.2 Flasher Compact LED indicators

LED Status Meaning

Ready /| GREEN .

0.K. short flicker Module is ready.
Flashing operation in progress:

Ready /| GREEN e Erasing (blinking at 6.25 Hz)

0O.K. slow blinking e Programming (blinking at 1.67 Hz)
e Verifying (blinking at 5 Hz)

:}le%td / RED a) The module is in bootloader mode.

Fail Y 7| constant b) The most recent operation has failed.

Flasher Hub User Guide (UM08039)
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21 CHAPTER 2 Storing configuration and programming data files

2.5 Storing configuration and programming data files

The configuration and programming data required to program the target devices is stored on
the connected Flasher Compact modules. Each Flasher Compact module has approximately
126MB of storage available for data and configuration files.

The Flasher Compact modules can be accessed in the following ways:

e via the J-Flash software
e via an FTP client connected to the Flasher Hub's integrated FTP-server
e via the File browser in the Flasher Hub’s web interface

When using J-Flash, the connected Flasher Compact modules (Module 1, Module 2, ...,
Module n) can be selected via tick boxes on the “Options > Project settings > General”
screen. Make sure to select TCP/IP as the connection type and enter the Flasher Hub’s IP
address (or use flasherhub-<serial_number>).

] STM32F40TVE - Project settings X
General
Target Interface
v MCU
Init. steps J-Flash is SEGGER's production programming
Exit steps software.
P It requires a license, which can be obtained from

Flash SEGGER (https: //www.seqger.com
Production X
Performance This software is capable of programming the flash

memory of several MCUs
and external fiashes connected to the MCL, as
well.

Connection type

O uss

O use sy

@ TCP/IP  [flasherhub-1021000000
Flasher ATE module selection

Module 1
Module 2
Module 3
Module 4
Module 5
[ Module &
[ Module 7
[ Module 8
[ Module o
[ Module 10

Al MNone Invert

User interface mode
(®) Engineering (More options, typically used for setup)
() simplified {Less options, typically used for production)

OK Cancel

When selecting “File > Download config & data file to Flasher” from the J-Flash menu, the
configuration and data file of the current J-Flash project will be downloaded to the selected
Flasher Compact modules.

E SEGGER J-Flash V7.22 - [CA\Workimischtest\STM32F
File Edit Target Options View Help
Open data file... Ctrl+0
Merge data file...
Save data file Ctrl+S

Save data file as...

Mew project
Open project
Save project
Save project as...

Close project

Save Flasher config file...
Save Flasher data file...
Download config & data file to Flasher

Download serial number file to Flasher

Recent Files 3
Recent Projects 3
Exit Alt+F4
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When using an FTP client or the file browser in the Flasher Hub’s web interface, the Flash-
er Compact modules are accessible via subfolders named “"MODULE.xxx”, with xxx being
the index of the associated Flasher Compact, e.g. "MODULE.001"” for the Flasher Compact

module with index 1.

The index of the connected Flasher Compact modules can be changed via the Flasher Hub

CHAPTER 2 Storing configuration and programming data files

web interface, on the “Configuration > Flasher” page

9/%

Overview

Configuration Status ~

Files

About Log

File browser

Current folder: |/

‘ Remove all files on all modules ‘

T T T

ied
:34:42

All modules

MODULE.001
MODULE.002
MODULE.003
MODULE.004
MODULE.005

Log.txt

Flasher Hub User Guide (UM08039)
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23 CHAPTER 2 Log files

2.6 Log files

The Flasher Hub keeps a log file if logging is enabled via the web interface on the “Config-
uration > Server” page. The log itself can be accessed on the “Log” page.

Configuration ~ Status - Files About Log

E Automatically scroll to bottom

MAIN | 2021-86-18 10:25:85 | SEGGER Flasher Hub V1.81a Log

MAIN | 2021-06-10 10:25:85 | Flasher Hub compiled: Jun 8 2021 11:33:59
MAIN | 2821-86-18 10:25:85 | Logging started @ 2021-86-10 18:25:05
MAIN | 2021-86-19 1@:25:85 | TELNET server is running...

MAIN | 2021-86-1@ 1@:25:85 | APPINST server is running...

MAIN | 2021-86-18 10:25:85 | Web server is running...

MAIN | 2021-06-1@ 10:25:85 | FTP Server is running...

MAIN | 2021-06-1@ 10:25:85 | VCOM/ RS232 interface is ready...

MAIN | 2021-086-1@ 10:25:85 | Handshake interface is ready...

MAIN | 2021-86-18 1@:25:85 | FIND interface is ready...

MAIN | 2821-86-18 10:25:85 | Flasher Hub is running...

MAIN | 2021-086-18 10:25:85 | Successfully verified server authenticity.

In addition, each Flasher Compact keeps its own log file. These log files are stored in the
module folder of the corresponding Flasher Compact and can be downloaded via FTP or
the file browser in the Flasher Hub’s web interface. For more information on the Flasher
Compact log file, please refer to the Flasher User Guide (UM08022).

Overview Configuration Status - iles Log

}>/sec.ﬁ

File browser

Current folder: [/MODULE.001/ |

T Drag and drop or select file(s) to upload:

| | Create new folder |
Choose Files | Mo file chosen

'Iodule 1: 544 KiB used of 124656 KiB (1% used, 99% free)

STM32F407VE 1080-01-01 00:00:00 | Directory
1980-01-01 00:00:00 | Log file 59 Bytes
D STM32F407VE.cfg 2021-06-10 10:30:26 | Configuration file | 4 KiB
[ STM32F407VE.dat 2021-06-10 10:30:26 | Data file 518 KiB
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2.7 Updating the Flasher Hub Firmware

Firmware updates for the Flasher Hub are provided on the Flasher download page htt ps://
www. segger . conl downl oads/ f | asher/ .

Note

Please note the Flasher Hub cannot be updated via J-Link Commander or J-Link Con-
figurator.

The Flasher Hub update package provides the update file Fi r mnar e. updat e. This file needs
to be uploaded via FTP to the root directory of the Flasher Hub.

After the upload process, the button in the Control section of the Flasher Hub web interface
“Overview"” page will say “"Restart now and apply update”. Click the button and wait for the
Flasher Hub to restart.

After the update, a new server version is displayed in the General information section of
the “Overview” page.

Note

It is recommended to use the most recent version of the Flasher Hub firmware as
newer versions may contain various improvements as well as bugfixes.

>; Overview Configuration Status ~ Files About Log

’/ SEGGER

Overview

Restart now and apply update
(V1.01a)

Restart

General information

1.00 (compiled Jun 8
2021 11:33:59)

Serial number 1021000000

Network information

Configuration Static

IP address 192.168.11.92 /16

Server version

Gateway 0.0.0.0
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2.8 Newline encoding

In general, for all patch files, init files etc., the Flasher Compact modules support both
newline encodings:

e Windows: \r\n
e Unix/Mac: \n

All parser functionality etc. are written to be independent from the host operating system.
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Setting up a project for the
Flasher Hub

In order to set up the Flasher Hub for parallel programming, the connected Flasher Compact
modules need to be configured once using either the J-Flash software or using the Universal
Flash Loader Configurator software. Both programs are part of SEGGER’s Flasher software
and documentation package, available for download free of cost at:

https://

www. segger . conl downl oads/ f | asher / #Fl asher Sof t war eAndDocunent at i onPack.
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3.1 Using J-Flash

J-Flash is SEGGER'’s desktop software for production prorgramming and it is available for
Windows, macOS and Linux. It can be used to create Flasher configuration and data files
for ARM-based target devices. For more information about J-Flash, please refer to the J-
Flash User Guide.

In order to set up the Flasher Hub for parallel programming, the connected Flasher Compact
modules need to be configured once using J-Flash.

After starting J-Flash, open the appropriate J-Flash project for the target device the Flasher
Compacts shall be configured for, by selecting File -> Open Project. If J-Flash does not
come with an appropriate sample project for the desired hardware, a new project needs to
be created by selecting File -> New Project.

After the appropriate project has been opened / created, the data file which shall be pro-
grammed needs to be loaded, by selecting File -> Open. Next, click on Options -> Project
settings -> General and select Connection type to be TCP/IP. As the TCP/IP address,
enter flasherhub-<serial_number>. You can find the serial number of your Flasher Hub
on the product housing.

Click Flasher Hub module selection and select the Flasher Compact module numbers
you would like to configure. Then click OK.

After this, J-Flash should look similar to the screenshot below.

ﬂ SEGGER J-Flash V7.22 - [C\Work\misc\test\STM32F407VE jflash] — X
File Edit Target Options Yiew Help
Project information F X CG\Work\misc\test\STM32F407VE.hex @ 08000000 5 X
Setting Value Go To: | viw||B B 8 |4
-1 General 02000000 00 03 00 20 01 04 00 08 . ._..__.. ~
Project name STM32F487VE 02000005 11 04 00 03 11 04 00 05 ........
. ' ' 08000010 21 04 00 03 21 04 00 08 ... l._.
Host connection TCP/IP [Host 'flasherhub-1821888886'] 02000018 31 04 00 02 31 04 00 08 1...1...
Flasher ATE selection 1, 2, 3, 4, 5 08000020 41 04 00 08 41 04 00 08 A...A. ..
-17IF 02000028 51 04 00 02 51 04 00 08 Q...Q...
Type ITAG 02000030 €1 04 00 08 €1 04 00 08 a...a...
. 02000032 71 04 00 02 71 04 00 02 g...g...
Init. speed 4888 kHz 08000040 S1 04 00 08 51 04 00 08 ... ...
Speed 4888 kHz 020000428 51 04 00 02 51 04 00 02 ... .....
TAP number a 0S000050 AL 04 00 08 AL 04 00 08 .---j.--
IRPre a 08000053 B1l 04 00 08 Bl 04 00 08 *.. .+ ..
02000060 CL 04 00 08 C1 04 00 083 A__ A .
[-1Target 08000068 DL 04 00 0% DL 04 00 08 W...H...
MCU 5T STM32F487VE 08000070 E1 04 00 08 E1 04 00 08 &...&...
Core Cortex-M4 02000078 Fl 04 00 02 F1 04 00 083 HA...A...
. . 08000080 01 05 00 08 01 05 00 08 . .......
Endian Little 08000088 11 05 00 08 11 05 00 08 ........
Check core ID Yes (Bx4BABBATT) 02000090 21 05 00 08 21 05 00 08 L..._0l.__
Use target RAM 128 KiB @ 9x20000000 02000088 31 05 00 08 31 05 00 08 Ll...1...
080000AR0 41 05 00 03 41 05 00 08 A...A...
[+]Flashbank No. o 02000028 S1 05 00 08 S1 05 00 08 Q.. .Q...
020000B0 €1 05 00 0% €1 05 00 08 a...a...
020000B8 71 05 00 08 71 05 00 08 gQ--.g--.-
020000C0 21 05 00 08 81 05 00 08 .. .._...
080000Cs 321 05 00 02 21 05 00 08 ........
08000000 RL 05 00 08 RL 05 00 08 ;...j...
020000D2 BL 05 00 02 BL 05 00 08 £...&. ..
0B0000ED €1 05 00 08 €L 05 00 08 A . A ..
0S0000Z8 DL 05 00 08 DL 05 00 08 W...H.._.
020000F0 EL 05 00 08 E1 05 00 08 &._ & .. v
Log 5 X
Application log started rs
- J-Flash v7.22 (1-fFlash compiled Jun 2 2821 18:83:48)
- JLinkARM.d11 v7.22 (DLL compiled Jun 2 2821 18:83:15)
Reading flash device list [C:“Program Files (88)\SEGGER\JLink\ETC/JFlash/Flash.csv] ...
- List of flash devices read successfully (451 Devices)
Reading mcuU device 1list ...
- List of MU devices read successfully (2479 Devices)
opening project file [C:work'mischtesth\STM32r4@7vE.jflash] ...
- Project opened successfully
opening data file [C:‘work\mischtest\STM32F487VE.hex] ...
- Data file opened successfully (524288 bytes, 1 range, CRC of data = @x57679A97, CRC of file = @xAEBCESDE) W

Ready
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Next, you can transfer the necessary files to the Flasher Compacts using File -> Download
config & data file to Flasher. Check the J-Flash Log window to make sure the file transfer
was successful. For further details please check the J-Flash manual.

Note

If J-Flash has trouble connecting to flasherhub-<serial_number>, use the actual
IP address of your Flasher Hub. You can find it on the “"Overview” page of the Flasher
Hub’s web interface.

From now on, the Flasher Hub and the attached Flasher Compacts can be used in stand-
alone mode (without host PC interaction) for stand-alone programming.

As an alternative to the process described above, you may also save the files to disk and
upload them to the Flasher Compacts via the web inteface. To do this, follow the instruc-
tions below:

1.

ouhknN

Save the configuration (project) file to disk by selecting File -> Save Flasher Config
File

Save the data (program data) file by selecting File -> Save Flasher Data File
Connect to the Flasher Hub Web interface via a browser.

Navigate to the file browser in the “Files” tab

Now the configuration file and the data file can be uploaded to the Flasher Hub module
folder(s) (MODULE.xxx), i.e. to the connected Flasher Compacts.

Choosing the All modules folder will upload the files to all Flasher Compacts connected
to the Flasher Hub. Note: The file(s) can be uploaded by dragging and dropping inside
the browser window.

E SEGGER J-Flash V7.22 - [C\Work\misc\test\STM32F

Eile Edit Target Options View Help

Open datafile... Ctrl+0
Merge data file...
Save data file Ctrl+5

Save data file as...

Mew project
Open project
Save project
Save project as...

Close project

Save Flasher config file...

Save Flasher data file...

Download config & data file to Flasher

Download serial number file to Flasher

Recent Files 3

Recent Projects 3

Exit Alt+F4

>\_ Overview Configuration » Status ~ Files About

}/ SEGGER

File browser

Current folder: |/ |

‘ Remove all files on all modules |

All modules 2021-06-08 10:34:42 | Directory
MODULE.001 2021-06-08 10:34:42 Directory
MODULE.002 2021-06-08 10:34:42  Directory
MODULE.003 2021-06-08 10:34:42 Directory
MODULE.004 2021-06-08 10:34:42  Directory
MODULE.005 2021-06-08 10:34:42 Directory
[ Log.txt [¥] | 2021-06-10 09:37:34 | Plain text file = 1058 Bytes
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A third option is to upload the configuration and data files to the Flasher Compact modules
via FTP as described here: FTP server on page 40.

If J-Flash also generates a .pex file (which is a device-specific flash programming algorithm
that is required for certain target devices), this also needs to be uploaded to the module
folder(s) for programming to be successful. Please note that it must be located in a sub-
folder with the same name as your project, e.g. if your project is named MyProject with
the project files MyProject.cfg and MyProject.dat, then the subfolder must be named
MyProject.

Current folder:][/MODULE.001/ | |

% Drag and drop or select file(s) to upload:

Choose Files | No file chosen

'Iodule 1: 536 KiB used of 124656 KiB (1% used, 99% free)

| | Create new folder |

| STM32F407VE | 1980-01-01 00:00:00 | Directory
[ STM32F407VE.cfg [#] | 2021-06-10 10:30:26 | Configuration file | 4 KiB
D STM32F407VE.dat |I| 2021-06-10 10:30:26 | Data file 518 KiB

Current folder:|[/MODULE.001/STM32F407VE/ |

* Drag and drop or select file(s) to upload:

Choose Files | No file chosen

lIoduIe 1: 536 KiB used of 124656 KiB (1% used, 99% free)

| K| Device.pexl Remaove 2021-06-10 10:30:26 | Flash programming algorithm file | 3808 Bytes

| | Create new folder |
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3.2 Using Universal Flash Loader

The Universal Flash Loader mode can be used to program non ARM-based targets. While
configurations generated with J-Flash rely on using the debug interface of the device, con-
figurations using the Universal Flash Loader make use of device or vendor specific pro-
gramming interfaces and protocols and therefore it is independent of the CPU core.

A Universal Flash Loader configuration can be created using SEGGER’s Universal Flash
Loader Configurator, available for Windows, macOS and Linux.

For details, please see the Universal Flash Loader User Guide (UM08037) as well as the
Flasher User Guide (UM08022).

[RsF104p28FB

Code Flash RL78.PEX (00000000
Data Flash RL72.PEX Cx000F1000

Flash Bank Loader Start Address End Address Sector Size  Blank Value  Size

*.dat|*.bin|.hex|.mot|.s].515].srec

Log initilized

0x0003FFFF  0x00000400 OxFF 256 KB
0x000F2FFF  0x00000400 OxFF 8KB
ﬂ SEGGER Universal Flash Loader Configurator V7.22 - Device selection x
§ I I I
Wendor Device FlashBanks Interface ~
Renesas R5F104PHDFA 192KB + B KB UART (TCK)
Bonnl | Renesas RSF104PHDFB 192 KE + B KB UART (TCK)
Renesas R5F104PHGFA 192KB + BKB UART (TCK)
Renesas R5F104PHGFB 192KB + B KB UART (TCK)
.| |Renesas RIF104PJAFA 256 KB + 8 KB UART (TCK)
Jf Renesas _RSFIOMPIAFB [256KB.8KB____JUART(ICK |
Renesas RSF104PIDFA 256 KB + B KB UART (TCK)
9 |Renesas R3F104PIDFE 236 KB + 8 KB UART (TCK)
Renesas RSF104PIGFA 256 KB + B KB UART (TCK)
o |Renesas R5F104PIGFB 256 KB + B KB UART (TCK)
Renesas RIF104PKAFA 3B4KB + B KB UART (TCK)
Renesas R5F104PKAFE 324KB + BKB UART (TCK)
Renesas RSF104PKGFA BAKB+ B KB UART (TCK)
Renesas RIF104PKGFE 3B4KB + B KB UART (TCK)
Renesas RSF104PLAFA 512KB + BKB UART (TCK)
Renesas RSF104PLAFE S12KB+ B KB UART (TCK)
Renesas R3F104PLGFA S12KB + 8 KB UART (TCK)
Renesas R5F104PLGFB 512KB + BKB UART (TCK)
Renesas R5F1051AASP 16KB+ 2 KB UART (TCK)
Renesas R3F1031AGSP 16KB + 2KB UART (TCK)
Renesas R5F1054AA5P 16KB + 2KB UART (TCK)
Renesas R5F1054AGSP 16KB+ 2 KB UART (TCK)
Renesas R3F1036AASP 16KB + 2KB UART (TCK)
Renesas R5F1056AGSP 16KB + 2KB UART (TCK)
Renesas RSF1057AANA 16KB+ 2 KB UART (TCK)
Renesas R3F1037AGNA 16KB + 2KB UART (TCK)
Renesas R5F1058AALA 16KB + 2KB UART (TCK) e
Cancel
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Chapter 4

Serial number handling

This chapter describes how to deals with serial numbers in a Flasher Hub based system.
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4.1 Serial number programming

A Flasher Hub based system supports programming of serial numbers. In order to use the
serial number programming feature, the J-Flash project to be used as well as some files
on the Flasher Compacts connected to the Flasher Hub (depending on the configuration)
need to be configured first.

In general, a Flasher Hub based system supports two ways of programming a serial number
into the target:

1. Programming continuous serial numbers. Serial number is 1-4 bytes in size. Start serial
number, increment, serial number size and address is configured in the J-Flash project.

2. Programming custom serial humbers from a serial number list file. Start line into serial
number list file to get next serial number bytes, line increment, serial number size and
address is configured in the J-Flash project. Serial number list file needs to be specified
and created by user.

Some generic information on how to setup the Flasher Hub based system & the J-Flash
project for serial number programming is provided below.

4.1.1 Serial number settings

In order to enable the programming of serial numbers in stand-alone mode, the J-Flash
project has to be configured to enable programming a serial number at a specific address.
This is done by enabling the Program serial number option as shown in the screenshot
and table below:

|
| t:l empower - Project settings >
| 8 1
Genera Target Power Supply
Target Interface
[ |+ mcu POAWET SOUTCE: VOCSY
Init. steps Deelay before start: |20 s
Bt steps ] Discharge target on disconnect
Flash
Production Reference voltage settings
| Performan —
| erormance Enable ¥Tref monitor
| Fioed VTref
|

[=] Program serial numiber
Address | 08001000
Length [4
Hext SH | 1234567

Increment | 1

Actions performed by 'Production Programming'
(] Erase selocted sactors
[+] Frogram

(] veerify

[] Start application

[] Disconnect afterwards

[ override timeouts

! Concl
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Setting Meaning

Addr ess The address the serial number should be programmed at.

The length of the serial number (in bytes) that should be pro-
grammed.

If no serial number list file is given, J-Flash allows to use a 1-4
byte serial number. In case 8 is selected as length, the serial
number and its complement are programmed at the given ad-
Len dress.

In case a serial number list file is given, the Flasher Hub will take
the serial number bytes from the list file.

If a serial number in the list file does not define all bytes of Len ,
the remaining bytes are filled with 0s. No complements etc. are
added to the serial number.

In case no serial number list file is given, Next SN is the next se-
rial number which should be programmed. The serial number is
always stored in flash memory in little endian format.

In case a serial number list file is given, Next SN describes the

Next SN line of the serial number list file where to read the next serial
number bytes from. The Flasher Hub starts counting at line 0, so
in order to start serial number programming with the first line of
the SNLi st .t xt, Next SN needs to be set to 0.

I ncr ement Specifies by how much Next SNis incremented.

4.1.2 Continuous Serial numbers

The Flasher Hub can generate serial humbers. Therefore the project can be configured to
use the serial nhumber feature (see on page 32). The Flasher Hub will use the first serial
number for the first programmed device. Then the increment is added to the serial number
and this is used for the next programming sequence. The next serial number is stored in
the SERIAL.TXT file on each Flasher Compact module. Therefore, the serial number is also
power-cycle safe. If the file is missing at start up time, the number 0 is used for the first
target.

To avoid duplication of serial humbers with the Flasher Hub using more than one Flasher
Compact module, there are two options:

¢ Use anincrement of the number of connected Flasher Compact modules; e.g. if you have
5 Flasher Compacts connected, use an increment of 5 as well as 5 different SERIAL.TXT
files at the beginning of production.

e Use different serial number areas; e.qg. if you have 5 Flasher Compacts connected, use
an increment of 1 as well as 5 different SERIAL.TXT files at the beginning of production.
For the first module, use the range from 1 to 1000, for the second 1001 to 2000, and
SO on.

The SERIAL.TXT file contains the value Next SN in ASCII notation, e.g. 1234 if the next
serial number is 1234.

Note

The serial number in SERIAL.TXT will also be incremented if serial number program-
ming is disabled, to make sure that for the Flasher Hub logfile there is a reference
for which programming cycle passed and which did not. As long as serial number
programming has not been enabled in the J-Flash project, the Flasher Hub does not
merge any serial number data into the image data to be programmed.

4.1.3 Serial number list file

In order to program custom serial numbers which cannot be covered by the standard serial
number scheme provided by J-Flash (e.g. when programming non-continuous serial hum-
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bers or having gaps between the serial numbers), a so called serial number list file needs
to be created by the user.

The SERIAL.TXT file needs to contain the values for the serial numbers in ASCII notation.
Each line in the file must contain one serial number.

Example

An 8-byte serial number should be programmed at address 0x08000000.
It should be programmed as follows in the memory:

0x08000000: 0x01 0x02 0x03 0x04 Ox55 0x66 0x77 0x88

The associated serial number list in the file should look as follows:

Test_SMList.tt - Notepad = ] X
File Edit Format View Help
| 8182630455667788
| @182030455667789
| B1e2038455667 78A
| e1@82030455667788
0182038455667 78C
| 18202045566 778D
B1e2038455667 78E
| 9182032455667 78F
0182030455667 790
@102830455667791
B182038455667 792
| 9182030455667 793
0182038455667 794
| 8162030455667795)

| |
| Ln 14, Col 17 100%  Windows (CRLF) UTF-8 I
The number of bytes to read per line is configured via the Len option in J-Flash. For more

information, please refer to Serial number settings on page 32.

Which line Flasher will read at the next programming cycle is configured via the Next SN
option in J-Flash. For more information, please refer to Serial number settings on page 32.
In this case, Next SN needs to be set to 0, since programming should start with the serial
number bytes defined in the first line of the file.

Note

If the number of bytes specified in a line of the serial number list file is less than the
serial number length defined in the J-Flash project, the remaining bytes are filled with
Os by the Flasher Hub.

Note

If the number of bytes specified in a line of the serial number list file is greater than
the serial number length defined in the J-Flash project, the remaining bytes will be
ignored by the Flasher Hub.

4.1.4 Programming process

The Flasher Compact modules connected to the Flasher Hub will increment the serial num-
ber in SERIAL.TXT by the value defined in | ncrenent after each successful programming
cycle.
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For each programming cycle, the FLASHER.LOG file on the connected Flasher Compact
modules is updated and contains the value from SERIAL.TXT that has been used for the
programming cycle.

Note

The serial number in SERIAL.TXT will also be incremented if serial number program-
ming is disabled, to make sure that for the Flasher Compact logfile there is a refer-
ence for which programming cycle passed and which did not. As long as serial number
programming has not been enabled in the J-Flash project, the Flasher Compacts do
not merge any serial number data into the image data to be programmed.

4.1.5 Example setup

Below, a small example is given on how to set up the Flasher Compacts for serial num-
ber programming. In the following example, 4-byte serial humbers starting at 1234567
(0x12D687) shall be programmed at address 0x08001000.

Defining serial number address, length and start value

In the J-Flash project, the following needs to be defined:

Addr ess is 0x08001000
Next SNis 1234567

I ncrenent is 1

Len is 4 (bytes)

: ﬂempoweu - Project settings >

| General

Target Interface
v MEU POWEr Source: VOCSY T

Target Power Supply

|
| Init. steps Deelay before start: |20 s

Exit steps
Flash
Production Reference voltage settings
Performance

: Discharge target on disconnect

] Enable vTref monitor

] Fied VTref

Program serial number
Address | 08001000
Length [4
Hext SH | 1234567

Increment | 1

Actions performed by 'Productson Programming'
(] Erase selocted sactors
[+] Frogram

(] veerify

[] Start application

[_] Disconnect afterwards

[ override timeouts

-
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Downloading configuration, data, and serial number to the Flasher Compacts

After setting up the rest of the configuration (Target interface etc.) and selecting an appro-
priate data file, the configuration, data, and serial number file needs to be transferred to
the associated Flasher Compact via the Flasher Hub, either using J-Flash, or using an FTP
client, or using the file browser in the Flasher Hub’s web interface.
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4.2 Limiting the number of programming cycles

The Flasher Hub provides a mechanism to limit the number of programming cycles that
can be performed in stand-alone mode with the configuration that is stored on the Flasher
Compacts. To make use of this feature, a file called Cnt down. t xt needs to be placed onto
the Flasher Compacts module folder. This file simply contains a decimal number (32-bit

unsigned integer) that describes how many programming cycles can be performed with
the current setup.

| EACntdown.txt - Notepad++ o 2=

File Edit Search VYiew Encoding Language Settings Macro Run  TedtFX Plugins Window I X
o= oolE:]‘ | |ﬂz‘éd“3’)|4'fl"=7‘ -JE‘

5] Crtdown.a £

1 5§

length:1 lines:1 Ln:1 Col:1 Sel:0|0 Des\Windows ANSI as UTF-8 INS

This feature especially makes sense when used in combination with authorized flashing.
For more information about authorized flashing, please refer to the Flasher User Guide.

Note

The number in Cnt down. t xt is only updated on a successful programming cycle. Pro-
gramming cycles that failed do not affect Cnt down. t xt .

4.2.1 Modified fail/error LED indicator behavior

In case a Cntdown. t xt is found at boot time, the fail/error LED of the Flasher Compact
behaves differently. If the number of programming cycles left is 10 or below, the following
will happen:

e The red error/fail LED will be lit for 1 second

e After this, it will blink/toggle x times @ 5 Hz, indicating the number of programming
cycles left (blinking 5 times for 5 cycles left, etc.)
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Patch data file

This chapter describes how a Flasher Hub based system can patch data files.
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5.1 Patch file support

The Flasher Compact modules connected to the Flasher Hub support patch files, which al-
lows to patch the content of the data to be programmed. Before starting the programming
process in stand-alone mode, the Flasher Compact module will look for a file named Pat ch-
es. t xt being present. This file includes the patches. If this file is present, the number in
Seri al .t xt describes the line number of the Pat ches. t xt file that will be used for the
current cycle (line counting starts at 0).

Each line in Pat ches.txt can hold up to 4 patches, where each patch can be up to 32
bytes in length.
Syntax

Each line begins with <NunPat ches> followed by each patch <Addr >, <NunByt es>: <Dat a>
in sequence and separated by commas. So the syntax for <NunPat ches> = 4 would be as
follows:

<NumrPat ches>, <Addr >, <NunByt es>: <Dat a>, <Addr >, <NunByt es>: <Dat a>, <Addr >,
<NumByt es>: <Dat a>, <Addr >, <NunByt es>: <Dat a>\r\n

Find below a table which describes each parameter.

Parameter Description

Describes the number of patches in this patch line. Max. val-

<NunPat ches> .
ue is 4.

Describes the address to be patched. Value is expected in

<Addr > hex
<NUBVt e > Number of bytes for the current patch. Max. value is 20h (32
y in decimal). Value is expected in hex.
<Dat a> Describes the data to be patched. <Data> is always expect-
ed as 2 hexadecimal characters per byte.
Note

All values are expected in hexadecimal format (hex).
The <Data> section is always preceded by “:”, not “,”.

Example

Please find below an example sequence which clarifies the usage of patch files.

Pat ches. t xt , which is located on the Flasher Compact(s), contains the following line:
3,100025,3:AABBCC,100063,2:DDEE,100078,1:FF

Seri al .t xt contains a “0”, which forces the Flasher Compact to use line 0 from Pat ch-
es. txt.

After starting the programming cycle, the following data will be patched:

Addr 0x100025: 3 byte 0xAA 0xBB 0xCC
Addr 0x100063: 2 byte 0xDD OxEE
Addr 0x100078: 1 byte OxFF

Single patch via Telnet

Alternatively, you can start a programming cycle with patch data that is only valid for this
one cycle (no need for a Pat ches. t xt file):

Send the #AUTO PATCH <nodul e> <NumPat ches>, <Addr >, <NunByt es>: <Dat a>

command via the Flasher Hub Telnet interface. The parameters have the same function as
described in the table above.
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Chapter 6

FTP server

This chapter describes the FTP server features.

Flasher Hub User Guide (UM08039) © 2020-2021 SEGGER Microcontroller GmbH



41 CHAPTER 6 FTP server connection

6.1 FTP server connection

The FTP server on the Flasher Hub provides easy access to the files on the connected
Flasher Compact modules. The server supports a maximum of 2 simultaneous connections
and works with all common FTP clients.

The FTP server root directory is a virtual directory and cannot be written to. It contains a
subdirectory for each module, as well as an “All Modules” directory.

Note that the assignment of Flasher Compact serial humbers to the Module numbers (MOD-
ULE.xxx) can be changed via the Flasher Hub web interface.

Remote site: | /AMODULE.DO3 -

r
—]-. F)

+- |, MODULEDO01
+- |, MODULE.002
+- |, MODULE.003

Filename Filesize Filetype Last moedified Perrnissions  Owner/Gro...
FLASHER File folder 01.01.80 drw-r--r-- root root

|| FLASHER.CFG 4.09 CFGFile 01.01.80 -PW-T---- root root

|| FLASHER.DAT 32,768 DAT File 01.01.80 -PW-F--T-- root root

|| FLASHER.LOG 119 Text Docw.. 010180 -PW-T---- root root

|| SERIAL.TXT 3 TXT File 01.01.80 -IW=F-=F-- roct root

The FTP server allows you to upload or download the target configuration and data files.

Files and folders uploaded to the “All Modules” directory automatically get copied to all
connected Flasher Compacts. Note that the “All Modules” directory itself does not retain
any files or folders and will always appear empty.

Please also note that you may have to perform a “"Refresh” operation on the Module folders
before the FTP client will display the ‘true’ content of these folders. This is because many
FTP clients tend to cache the folder contents and don’t necessarily refresh the display
automatically, even if the folder contents has changed.

The Flasher Compacts create log files for executed operations. These files can be found in
the modules folders and downloaded from there.

The IP setup is described here: Setting up the IP interface on page 18.
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6.1.1 Access data

Anonymous access to the FTP server is limited to read-only access to the file system.
For write access, special login credentials have to be used:

FTP server connection

Flasher Hub User Guide (UM08039)

Setting Value
Host name ftp://flasherhub-<serial_number>
Username admni n
Password 1234
Port 21 (Default FTP port)
Note
The access data for read/write access can not be modified and is intended to be used
only as a convenience feature to avoid unintended modification of the Flasher’s file
system. It is not meant as a security feature.
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Chapter 7

Web server

This chapter describes the web server features.
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7.1 Web server features

The Flasher Hub comes with a built-in web server, which provides a web interface for
information and network configuration.

The web interface provides information about the Flasher Hub server version, serial num-
ber, and configuration. The Flasher Hub’s web interface furthermore allows monitoring and
configuration of the individual modules as well as the files stored on them.

The IP setup is described here: Setting up the IP interface on page 18.

7.1.1 Overview page

The “Overview” page shows the general parameters and status of the Flasher Hub. It also
allows to reset the Flasher Hub.

>\_

) Overview Configuration v Status ~ Files About Log
/ SEGGER

Overview

Restart Restart now

General information

Server version 1.01a (compiled May 17 2021 10:19:45)
Serial number 1021000001

Network information

Configuration Static
IP address 192.168.1.13 /24
Gateway 0.0.0.0

Last program result O.K.

- -

reserved

Copyrigh X Microcontroller GmbH All rig

For more information, website www.segger.com or contact us at info@segger.com
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7.1.2 Server configuration page

The “Configuration > Server” page allows the configuration of the handshake interface (for
future feature expansion use only - leave disabled for now). It also allows enabling/disabling
the logging feature of the Flasher Hub.

>\_ Overview Configuration ~ Status Files About Log

’/ SEGGER

Configuration > Server

Handshake Interface

OEnabled
@ Disabled
Logging
@® Enabled
ODisabled

X Microcontroller GmbH All rights reserved

WWW.5egger.com or contact fo@segger.com
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7.1.3 Flasher configuration page

The “Configuration > Flasher” page shows the serial numbers of the Flasher Compacts that
are currently connected to the Flasher Hub. It also allows users to change the association
between module number (Index) and Flasher Compact serial number.

To assign a specific Flasher Compact to a specific module number, choose the desired index
from the drop-down menu. Please make sure each index is unique, otherwise the changes
cannot be saved.

>\_

) Overview Configuration ~ Status Files About Log
/SEGGER

Configuration > Flasher

Module positions

Serial number Product name
1015000015 I Flasher Compact V5.00
1015000016 I Flasher Compact V5.00
1015000017 I Flasher Compact V5.00

Save

ontroller GmbH Al rights res

segger.com or conta egger.com
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7.1.4 Server status page

The “Status > Server” page shows system uptime and handshake interface status (for
future feature expansion use only).

>\_ Overview Configuration ¥ Status v Files About Log

>/ SEGGER

Status > Server

System uptime 3 days 6 hours 56 minutes 18 seconds
Status Disabled
Start N/A
Pin states OK N/A
Busy N/A

icrocontroller G

ed
For more information, o ite www.segger.com © act u info@segger.com
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7.1.5 Flasher status page

The “Status > Flasher” page shows the current status of the connected Flasher Compact
modules, including the current firmware version. If an updated verion of the Flasher Com-
pact firmware is available, this page will indicate this and allow the user to perform the
firmware update with the click of a button.

>\_ Overview Configuration ~ Status v Files About Log

b/ SEGGER

Status » Flasher

Module status

Status Serial no. Product Firmware
1 I 0.K. 1015000015 Flasher Compact V5.00 J-Link / Flasher Compact V5 compiled Mar 17 2021 11:50:31
2 I 0.K. 1015000016 Flasher Compact V5.00 J-Link / Flasher Compact V5 compiled Mar 17 2021 11:50:31
3 I 0.K. 1015000017 Flasher Compact V5.00 J-Link / Flasher Compact V5 compiled Mar 17 2021 11:50:31

crocontroller GmbH All rights

ed
For more information our website www.segger.com or contact us at info@segger.com
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7.1.6 Files page (File browser)

The file browser on the “Files” page is an alternative to using an FTP client to manage
the files on the connected Flasher Compacts. Users can view the contents of each module,
upload files (also via drag-and-drop), delete files and folders, create new folders, and more.

Web server features

Just like when connecting via FTP, Files uploaded to / new folders created in the “All mod-
ules” directory automatically get copied to all connected Flasher Compacts. Note that the
“All modules” directory itself does not retain any files or folders and will always appear

empty.

The FTP server root directory is a virtual directory and cannot be written to. Enter a specific
module directory or the “All modules” directory to upload files.

Note that the assignment of Flasher Compact serial nhumbers to the Module numbers (MOD-

ULE.xxx) can be changed via the Flasher configuration page.

9/%

Overview

Configuration Status ~

Files

About Log

File browser

Current folder: |/

‘ Remove all files on all modules ‘

T T T

ied
:34:42

All modules

MODULE.001
MODULE.002
MODULE.003
MODULE.004
MODULE.005

[ Log.txt

Flasher Hub User Guide (UM08039)

2021-06-08 10

Remove files 2021-06-08 10:
Remove files 2021-06-08 10:
Remove files 2021-06-08 10:
Remove files 2021-06-08 10:
Remove files 2021-06-08 10:

|I| 2021-06-10 09:

34:
34:
34:
34:
34:
37:

42
42
42
42
42
34

Directory
Directory
Directory
Directory
Directory
Directory

Plain text file

1058 Bytes
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7.1.7 Log page

CHAPTER 7

The “Log” page shows the log kept by the Flasher Hub.

Qverview

>\_

’/ SEGGER

Configuration v

Status v Files About Log

Web server features

Log

“Automatically scroll to bottom

MAIN | 2021-05-22 02:02:
MAIN | 2021-05-22 02:02:
MAIN | 2021-05-22 02:02:
MAIN | 2021-05-22 02:02:
MAIN | 2021-05-22 02:02:
MAIN | 2021-05-22 02:02:
MAIN | 2021-05-22 02:02:
MAIN | 2021-05-22 02:02:
MAIN | 2021-05-22 02:02:
MAIN | 2021-05-22 02:02:
MAIN | 2021-05-22 02:02:
MAIN | 2021-05-22 02:02:

el
el
el
el
el
el
el
el
el
el
el
el

SEGGER Flasher Hub V1.ela Log

Flasher Hub compiled: May 17 2021 10:19:45
Logging started @ 2021-05-22 ©2:02:01
TELNET server is running...

APPINST server is running...

Web server is running...

FTP Server is running...

VCOM/ RS232 interface is ready...
Handshake interface is ready...

FIND interface is ready...

Flasher Hub is running...

Successfully verified server authenticity.

Flasher Hub User Guide (UM08039)

ved

fﬁ@seg ger.com

Copy ont n
For more information, p our v in
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Chapter 8

Remote control

This chapter describes how to control the Flasher Hub based system via the integrated
Telnet interface.

Flasher Hub User Guide (UM08039) © 2020-2021 SEGGER Microcontroller GmbH



52 CHAPTER 8 Overview

8.1 Overview

The integrated Telnet interface is the primary way to remote-control the Flasher Hub op-
eration.

In the future, remote control via handshake lines may be added.
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8.2 ASCIl command interface

8.2.

8.2.

8.2.

8.2.

8.2.

1 Introduction

The Flasher Hub can be driven by any application or just a simple terminal using ASCII
commands.

Every known command is acknowledged by the Flasher Hub and then executed. After com-
mand execution, the Flasher Hub sends an ASCII reply message.

Note

There are situations where the execution of a known command is rejected with
#NACK:ERRxxx if the Flasher Hub is currently busy and the received command is not
allowed to be sent while the Flasher Hub is busy.

2 General command and reply message format

e Any ASCII command has to start with the start delimiter #.
e Any ASCII command has to end with simple carriage return (‘\r’, ASCII code 13).
Commands can be sent upper or lower case.

3 General usage

Reply messages must be considered in each case. In general, a new command must not
be sent before a reply for the last one has been received. At least the “"#ACK” message
needs to be received by the controlling application before sending a new command for a
flash module not yet executing a command.

For the Flasher Hub, all commands triggering a flash programming function (#AUTO, #CAN-
CEL, #ERASE, #PROGRAM #VERI FY) may be used for other modules, before the current op-
eration has been finished. Please note that in this case the overall finish indicator “#DONE"
will be sent when all commands have been executed.

When a flash programming function has finished, the debug logic of the MCU is disabled
(powered down) and the target interface of the module is switched off (tristated).

4 Settings for ASCIl interface via Telnet

A client application can connect to the Flasher Hub via Telnet on port 23. Find below a
screenshot of a Flasher Hub being remote controlled via Telnet:

¥ flasherhub-1021000001 - Tera Term VT - [m] x ‘

File Edit Setup Contrel Window Help

» Hub VUi.8ia compiled May 17 2021 18:19:45

#RESULT:1:0K (Total 8.417s, Erase 1.058s, Prog 6.526s,. Uerify 0.684s)
#DONE

5 Commands and replies

The table below provides an overview about the commands which are supported by the
current version of the Flasher Hub firmware. Click on the names for a detailed description:
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Commands to the Flasher Hub

#AUTO <Modul el>[, <Mbdul e2>]

#AUTO NOPATCH <Modul el>[, <Mbdul e2>]

#AUTO PATCH <Mbdul el>[, <Mbdul e2>] [nunber of patches],[address], [ nunber of
pat ched bytes]:[data bytes]

#CANCEL <Modul el1>[, <Modul e2>]

#ERASE <Mbdul el>[, <Mbodul e2>]

#FW/ERSI ON

#FVWERSI ONMOD <Modul el>[ , <Mbdul e2>]

#| PCONFI G

#POWERON <Mbdul el>[, <Modul e2>], [ Power Source, Di scharge Mode]

#POWNEROFF <Mbdul e1>[ , <Modul e2>]

#PROGRAM <Modul el>[ , <Mbdul e2>]

#PROTVER

#RESULT <Modul el1>[, <Mbdul e2>]

#SELECT <Modul el1>[, <Modul e2>] <Fi |l enane>

#SETVTREF <Modul el1>[, <Modul e2>] <vtref voltage in nv>

#START <Mbdul el>[, <Modul e2>]

#STATUS

#VERI FY <Modul e1>[, <Modul e2>]

#SELMODULE <Modul el>[, <Mbdul e2>]

#SERI AL

#SERI ALMOD <Mbdul el1>[, <Mbdul e2>]

#SETVTREF <Modul el>[, <Modul e2>] [vol t age]

Replies from the Flasher Hub

#ACK

#NACK

#OK

#OK: <NunByt es>: <Dat a>

#OK: <Dat a>

#OK: <Modul e>: <Dat a>

#RESULT: <Modul e>:

#DONE

H#HERRXX X
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ASCIlI command interface

8.25.1 Commands to the Flasher Hub

8.25.1.1 Command #AUTO

Flasher Hub User Guide (UM08039)

The #AUTO command behaves exactly like pushing the programming button on a connected
Flasher Compact.

Usually, the following command sequence will be performed when receiving the #AUTO
command:

e The Flasher Hub erases the target MCU (if not blank)
e The Flasher Hub programs the target MCU
e The Flasher Hub verifies the target MCU

Depending on the settings chosen in the Production tab in the J-Flash tool, this sequence
can differ from the one shown above.

Command structure:

#AUTO [ nmodul e1] [, nodul e2][, nodul e3]

Alternatively the modules can be replaced with:

o * will execute the aut o command using all modules selected by the latest executed
sel modul e command.
e all, will execute the aut o command using all modules which can be detected.

Results provided by the Flasher Hub:

Result Meaning

#OK Programming done successfully.

Error occurred during operation. xxx represents the error

HERRXXX code, which may be followed by an additional error text.

During execution of the #AUTO command, the Flasher Hub automatically sends “status”
messages via the terminal connection to reflect the state of execution.

Example sequence:

Command sent to the Flasher Hub Reply
#AUTO 1

#ACK

#RESULT: 1: OK (Total 13.993s, Erase
0.483s, Prog 9.183s, Verify 2.514s)

#DONE
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8.25.1.2 Command #AUTO NOPATCH
The #AUTO NOPATCH command allows to ignore an existing patch file for the programming.

This command exists because the default behavior of the #aut o command is such that

an existing patch file (pat ch. t xt in the module folder) is applied to a data if the #auto
command is executed.

The Flasher Hub responds with

e #OK if no error occurred

e #ERRxxx if any error occurred during operation. xxx represents the error code, which
may be followed by an additional error text.

For further information about the usage of the #AUTO PATCH command, please refer to
Patch file support on page 39.

Example sequence:

Command sent to the Flasher Hub Reply
#AUTO NOPATCH 1

#ACK

#RESULT: 1: OK (Total 13.993s, Erase
0.483s, Prog 9.183s, Verify 2.514s)

#DONE
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8.25.1.3 Command #AUTO PATCH

The #AUTO PATCH command allows patching of the content of the data to be programmed.
The Flasher Hub responds with

e #OK if no error occurred

e #ERRxxx if any error occurred during operation. xxx represents the error code, which
may be followed by an additional error text.

For further information about the usage of the #AUTO PATCH command please refer to Patch
file support on page 39.

Example sequence:

Command sent to the Flasher Hub Reply
#AUTO PATCH 1 1, 0, 8:0011223344556677

#ACK

#RESULT: 1: OK (Total 13.993s, Erase
0.483s, Prog 9.183s, Verify 2.514s)

#DONE
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8.25.1.4 Command #CANCEL

This command can be sent to abort a running operation. It may take a while until the
current operation is actually canceled.

Command structure:
#Cancel [nodul el][, nodul e2][, nodul e3]

Example:
Command sent to the Flasher Hub Reply

#AUTO 1
#ACK

#CANCEL 1
#ACK
#RESULT: 1: ERR255: Error while flash-
ing
#DONE
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8.25.1.5 Command #ERASE
This command can be sent to erase all selected target flash sectors.
Command structure:

#ERASE [ nodul el1] [, nodul e2] [, nodul e3]
Results provided by the Flasher Hub:

Result Meaning
#OK Erase done successfully.
#ERRxxx: TEXT Error message with text

Example sequence:

Command sent to the Flasher Hub Reply
#ERASE 1
#ACK
#RESULT: 1: K (Total 0.362s, Erase
0. 252s)
#DONE
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8.25.1.6 Command #FWVERSION

ASCIlI command interface

This command returns the firmware version of the Flasher Hub.

Command structure:
#FWERSI ON

Example sequence:

Command sent to the Flasher Hub Reply
#FW/ERSI ON
#ACK
#OK: 1: 1. 00
#DONE

Flasher Hub User Guide (UM08039)
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8.25.1.7 Command #FWVERSIONMOD

This command returns the firmware version of one or more modules connected to the
Flasher Hub.

Command structure:
#FW/ERSI ONMOD [ nodul el] [, nodul e2] [, modul e3]

Example sequence:

Command sent to the Flasher Hub Reply
#FW/ERSI ONMOD 1, 2, 3

#ACK

#OK: 1: J-Link / Fl asher Conpact V5
conpi led Mar 17 2021 11:50: 31

#OK: 2: J-Link / Fl asher Compact V5
conpi l ed Mar 17 2021 11:50: 31

#OK: 3: J-Link / Fl asher Conpact V5
conpiled Mar 17 2021 11:50:31

#DONE
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8.2.5.1.8 Command #IPCONFIG

This command returns the current IP configuration.

Command structure:
#1 PCONFI G

Example sequence:

Command sent to the Flasher Hub Reply
#1 PCONFI G

#ACK

#RESULT: | P address: 192.168. 1. 111
#RESULT: subnet mask: 255. 255. 0.0
#RESULT: Gat eway: 192. 168. 1.1

#RESULT: | P npde: aut omat i c( DHCP) as-
si gned

#DONE

IP mode can be aut onat i c( DHCP) assi gned or User assi gned.
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8.25.1.9 Command #POWERON

This command can be used to turn ON the target power (5V on pin 19 of the attached

Flasher Compacts) without any erase, program or verify action.

Command structure:

ASCIlI command interface

#POWERON [ modul e1] [, nodul e2] [, nodul e3] [ Power Source], [ Di schar ge]
The #PONERON command expects the following parameters:

Parameter

Meaning

Power Source

0 = internal power

Discharge

0 = no discharge

Example sequence:

Command sent to the Flasher Hub

Reply

#PONERON 1,2,3 0,0

#ACK

#DONE

Flasher Hub User Guide (UM08039)
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8.25.1.10 Command #POWEROFF

This command can be used to turn OFF the target power (5V on pin 19 of the attached
Flasher Compacts) without any erase, program or verify action.

Command structure:
#POWEROFF [ nodul el] [, nodul e2] [, modul e3]

Example sequence:

Command sent to the Flasher Hub Reply
#POWEROFF 1, 2, 3

#ACK
#DONE
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8.25.1.11 Command #PROGRAM

This command can be used instead of #AUTOto program a target without erasing the target
before programming and without performing a final verification.

Command structure:
#PROGRAM [ nodul el] [, nodul e2] [, nodul e3]

The Flasher Hub will reply with the following sequence of messages:

Example sequence:

Command sent to the Flasher Hub Reply
#PROGRAM 1
#ACK
#RESULT: 1: K (Total 9.963s, Prog
9. 183s)
#DONE
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8.2.5.1.12 Command #PROTVER
This command can be used to check the version of the ASCII command protocol in use.
Command structure:

#PROTVER

Example sequence:

Command sent to the Flasher Hub Reply
#PROTVER
#ACK
#OK: 2. 02h)
#DONE
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8.25.1.13 Command #RESULT

This command can be sent any time, even during other command execution. The Flasher
Hub responds with the result of the previously executed command.

Command structure:
#RESULT [ nodul el] [, nodul e2] [, nodul e3]

Example sequence:

Command sent to the Flasher Hub Reply
#RESULT 1, 2, 3

#ACK

#RESULT: 1: OK ((Total 2.216s, Erase
0.126s, Prog 1.231s, Verify 0.144s)

#RESULT: 2: K ((Total 2.216s, Erase
0.126s, Prog 1.231s, Verify 0.144s)

#RESULT: 3: K ((Total 2.216s, Erase
0.126s, Prog 1.231s, Verify 0.144s)

#DONE
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8.25.1.14 Command #SELECT

The #SELECT command is used to select a specific configuration and data file pair to be
used by the connected Flasher Compact modules to program the target.

Command structure:

#sel ect [nodul el] [, nodul e2] [, nodul e3] [ Project Nane]

The #SELECT command expects the following parameters:

Parameter

Meaning

Project Name

The [ Proj ect Nane] specifies the name of file pair without ex-
tensions (.CFG and .DAT) on the Flasher Compact modules to be
selected. The Flasher Compacts save the selected configuration
and data file in the FLASHER.INI file. Therefore, this selection is
remembered even after power-cycling the Flasher Compacts.

Example sequence:

Command sent to the Flasher Hub Reply

#SELECT 1, 2, 3 enPower

#ACK

#RESULT: 1: K

#RESULT: 2: K

#RESULT: 3: K

#DONE

Flasher Hub User Guide (UM08039)
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8.25.1.15 Command #SERIAL

ASCIlI command interface

The #SERI AL command is used query the serial number of the Flasher Hub.

Command structure:

#seri al

Example sequence:

Command sent to the Flasher Hub

Reply

#seri al

#ACK

#RESULT: 1021000001

#DONE

Flasher Hub User Guide (UM08039)
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8.25.1.16 Command #SERIALMOD

The #SERI ALMOD command is used query the serial numbers of the connected Flasher Com-
pact modules.

Command structure:
#SERI ALMOD [ modul el1] [, modul e2] [, nodul e3]

Example sequence:

Command sent to the Flasher Hub Reply
#serialnmod 1,2,3

#ACK

#RESULT: 1: 1015000015
#RESULT: 2: 1015000016
#RESULT: 3: 1015000017
#DONE
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8.25.1.17 Command #START

This command can be sent to start the application using the method configured in the J-
Flash project.

Command structure:
#START [ nodul el] [, nodul e2] [, nodul e3]

Example sequence:

Command sent to the Flasher Hub Reply
#START 1,2, 3

#ACK

#RESULT: 1: OK (Total 0.083s)
#RESULT: 2: OK (Total 0.082s)
#RESULT: 3: OK (Total 0.084s)
#DONE
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8.25.1.18 Command #STATUS

ASCIlI command interface

This command can be sent any time, even during other command execution. The Flasher
Hub responds with its current state. All defined state messages are described under Replies

from Flasher Hub on page 76.

Command structure:
#STATUS

Example sequence:

Command sent to the Flasher Hub

Reply

#STATUS

#ACK

#STATUS: READY
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8.25.1.19 Command #VERIFY

This command can be used to verify the target flash content against the data stored in the
Flasher Compact module.

Command structure:
#VERI FY [ nodul el] [, nodul e2] [, nodul e3]

Example sequence:

Command sent to the Flasher Hub Reply

#VERI FY 1, 2,3
#ACK
#RESULT: 1: OK (Total 0.206s, Verify
0. 129s)
#RESULT: 2: K (Total 0.210s, Verify
0. 131s)
#RESULT: 3: OK (Total 0.207s, Verify
0.128s)
#OK
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8.2.5.1.20 Command #SETVTREF
This command can be used to set a fixed voltage for I/O pins of the target interface.

Command structure:

#SETVTREF [ nodul el] [, nodul e2] [, nodul e3] [vol tage |evel]
The SETVTREF command expects the following parameters:

Parameter Meaning

voltage level The IO voltage level for the target interface in mV.

Example sequence:

Command sent to the Flasher Hub Reply
#SETVTREF 1, 2, 3 3300

#ACK
#DONE
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8.2.5.1.21 Command #SELMODULE
This command is used to select one or more modules in a Flasher Hub system. The module
numbers are separated by a comma. If all modules shall be selected, the keyword “all” can
be used (#SELMODULE ALL) instead of a list with all module numbers.
Command structure:
#SELMODULE [ nmodul el] [, nmodul e2] [, modul e3]

Example sequence:

Command sent to the Flasher Hub Reply
#SELMODULE 1, 2, 3

#ACK
#SELECTED: 1, 2, 3
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8.2.5.2 Replies from the Flasher Hub

The reply messages from the Flasher Hub follow the same data format as commands. Any
reply message starts with ASCII start delimiter #, ends with simple carriage return (ASCII
code 13), and is sent in uppercase. In contrast to commands, replies can be followed by
a descriptive message, which provides more detailed information about the reply. This
description is sent in mixed case. The #K reply, for example, is such a reply. It is followed
by a string containing information about the performance time needed for the operations:

#OK (Total 13.993s, Erase 0.483s, Prog 9.183s, Verify 2.514s)

The following reply messages from the Flasher Hub are defined:

8.25.2.1 #ACK

The Flasher Hub replies with the #ACK message on reception of any defined command before
the command itself is executed.

8.25.2.2 #NACK

The Flasher Hub replies with #NACK, if an undefined command was received.

8.2.5.2.3 #OK:<module>:<data>

The Flasher Hub replies with #0OK, if a command other than #STATUS or #RESULT was exe-
cuted and ended without any error. #0OK may be followed by a module number and/or data.

8.25.2.4 #STATUS:<status>
The Flasher Hub replies with its current state.

The following status messages are currently defined:

Message Description

Flasher Hub is ready to receive a new

#STATUS: READY
command.

Flasher Hub is currently executing a previ-

#STATUS: BUSY ;
ously received command.
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8.25.25 #RESULT:<module>:<data>

The Flasher Hub reports the result of an operation on a specific module. If the operation
has been completed successfully, it will report the outcome with a single message of this
type followed by the last result of the operation.

8.25.2.6 #DONE

This message is being sent once all operations are finished and all connected Flasher Com-
pact modules are back in idle state.

A typical sequence for using the Flasher Hub is shown below:

Fl asher Hub tel net-shell telnet-shell.

Fl asher Hub V1.0la conpiled May 17 2021 10:19: 45

#SELMODULE 1, 2

#ACK

#SELECTED: 1, 2

#AUTO *

#ACK

#RESULT: 1: #ERR255: Error whil e fl ashing

#RESULT: 2: #OK (Total 2.653s, Erase 0.327s, Prog 1.960s, Verify 0.234s)
#DONE

8.2.5.2.7 #ERRxxx <data>

If any command other than #STATUS or #RESULT was terminated with an error, the Flasher
Hub cancels the command and replies with an error message instead of the #0K message.

Some error codes may be followed by a colon and an additional error text.
For example:
#ERROO7: CANCELED.

The error code numbers are described in the following table:

Message Description

#ERROO7T Flasher Hub received a #CANCEL command
and has canceled the current operation.

#ERRO0S FIasher_ Hub is already busy with execution
of previous command.

#ERRO09 Failed to allocate memory.

#ERR010 Failed to open file.

#ERRO11 Failed to read file.

#ERR012 Failed to write file.

#ERRO13 Failed to delete file.

#ERR098 Failed to delete file.

#ERRO98 Could not allocate memory for device spe-

cific algorithm.

Device specific algorithm is not yet sup-
#ERR099 ported by this firmware version. Please
check for a firmware update.

Could not find device programming algo-

#ERRLO1 rithm.
#ERR102 Could not open the data file.
#ERRO55 Undefined error occurred. This reply is fol-

lowed by an error string.
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Support and FAQs

This chapter contains troubleshooting tips together with solutions for common problems
which might occur when using the Flasher Hub. There are several steps you can take before
contacting support. Performing these steps can solve many problems and often eliminates

the need for assistance. This chapter also contains a collection of frequently asked questions
(FAQs) with answers.
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9.1 Contacting support

Before contacting support, make sure you tried to solve your problem by trying your Flasher
Hub with a different PC and (if possible) with a different target system to see if it works
there. If the device functions correctly, the USB setup on the original machine or your target
hardware is the source of the problem, not the Flasher Hub.

If you need to contact support, send the following information to
ticket_flasher@segger.com

A detailed description of the problem

Flasher Hub serial number

Information about your target hardware (processor, board, etc.).

FLASHER. JFLASH, FLASHER. CFG, FLASHER. DAT (if possible), FLASHER. LOG, SERI AL. TXT
file from the connected Flasher Compact. To get these files, please download them via
FTP or via the Flasher Hub web interface.

The Flasher Hub is sold directly by SEGGER.
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9.2 Frequently Asked Questions

Maximum target interface speed

Q: What is the maximum target interface speed supported by Flasher Compact?
A: The Flasher Compact’s maximum supported target interface speed is 50MHz.

Maximum download speed

Q: What is the maximum download speed supported by Flasher Compact?

A: The maximum download speed is currently about 3 Mbytes/second when downloading
into RAM. The actual speed depends on various factors, such as target interface speed,
clock speed, host CPU core etc.

Flasher Hub web interface access

Q: How do I connect to the Fasher Hub’s web interface?
A: Locate the serial number of your Flasher Hub on the product housing. Then point your
browser to http://flasherhub-<serial_number>/index.htm

Flasher Hub IP address

Q: Where can I find the IP address assigned to my Flasher Hub?
A: Connect to the Flasher Hub web interface as described above. The Flasher Hub IP
address is located on the “"Overview” page.
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Chapter 10

Mechanics

If you need to mount the Flasher Hub into the production environment, a drawing of the
mechanical layout can be downloaded here:
https://www.segger.com/downloads/flasher#Mechanics.
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Literature and references

This chapter lists documents, which we think may be useful to gain a deeper understanding
of technical details.
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CHAPTER 11

Reference Title Comments
J-Link / J-Trace User This document describes J-Link and J-
[J-Link] Guide Trace. It is publicly available from SEGGER
(https://www.segger.com).
This document describes J-Flash. It is
[J-Flash] J-Flash User Guide publicly available from SEGGER (https://
www.segger.com).
[Flasher HUb | bjasher Hub wiki https://wiki Flasher Hub
wiki] asher Hub wiki pages ttps://wiki.segger.com/Flasher_Hub.
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